
Increasing System Performance
If your machine just meets minimum system requirements, try the following to increase system performance:

Close all other applications when using this product.
u Have Windows manage your computer's virtual memory settings:

1. Windows 95 users click here  to display System Properties.
2. Click the Performance tab.
3. Click Virtual Memory, and then choose Let Windows Manage My Virtual Memory Settings 

(Recommended).
u Defragment your computer's hard drive:
1. Click Start, and then point to Programs.
2. Point to Accessories, and then point to System Tools.
3. Click Disk Defragmenter.

Note    If necessary, install Disk Defragmenter using the Add New Programs icon in Control Panel.

u Optimize Windows CD-ROM drive settings:

1. Windows 95 users click here  to display System Properties.
2. Click the Performance tab.
3. Click File System, and then click the CD-ROM tab.
4. Increase the size of the Supplemental Cache for your CD-ROM. Also check that the settings and 

speed in the Optimize Patterns For box are correct.
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Audio Performance Problems
Mastering Internet Development uses the following type of sound file:

WAVE (*.WAV): Digitized audio
To hear these sounds, you must have a sound card that is capable of playing WAVE sounds.

Your sound card uses a special piece of software called a "sound driver" to communicate with your computer. In 
some instances, you may not get any sounds when using Mastering Internet Development. Usually this is 
because your sound driver is not installed or is configured improperly. If you do not hear any sounds, or get an 
error message saying that there is a problem with your sound card or sound driver when you start the program, 
the WAVE portion of your sound driver may be either improperly configured or not installed.
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 I got an error message about my sound
The two most common errors about WAVE sounds are:

"A sound card is required to run Mastering Internet Development."
"Mastering Internet Development cannot get the sound device right now, it's in use elsewhere, try again."

If you receive the first error message, it usually indicates that your sound driver is either not installed, not 
installed correctly, or not configured correctly. If you receive the second error message, it usually indicates that 
your sound driver is in use by another open program. Solve this by closing all other open programs, and 
restarting Mastering Internet Development.

For more information on troubleshooting WAVE errors, see I can't hear any sounds.
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I can't hear any sounds
u If sound does not play at all:
1. Check the volume on your sound card or speakers, and turn up the volume if necessary.
2. Check that the speakers are connected to your computer, that the speaker power switch is on, and that the 

batteries (if any) are functional.
3. Check that the audio card software is installed correctly; reinstall it if necessary.
4. Ensure that the audio card is pressed securely into its slot, or change a jumper setting on the audio card.
5. If you have both an audio card and special software that bypass the audio card to play sounds through the PC

speaker, try removing or disabling the PC speaker driver. This product requires MPC-compatible audio; it is 
not meant to run with only the PC internal speaker or any combination of that speaker and special software.
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Checking Your Sound Card
u To ensure that your sound card is installed properly:

1. Windows 95 users click here  to display System Properties.
2. On the Device Manager tab, click the plus sign next to Sound, video and game controllers, and 

then double-click the name of your sound card.
3. On the General tab, look under Device Status to see if the device is working properly.

Note    If your sound driver is not working properly, please contact your sound card manufacturer.

Related Topics



My sounds are "scratchy"
Sound distortion is often caused by sending a higher volume or amplitude of sound than the speakers are able 
to handle. Also, if the volume control on your audio card is set too high, it may cause distortion from the amplifier
on the audio card. Sometimes lower-quality speakers distort at a lower volume than better-quality speakers.

For example, if your audio card or "WAVE file output" volume is set to near maximum, it will cause distortion. To 
change your audio card settings, refer to the manuals that came with your audio card.

To adjust the volume control:

1. Click here  to open Volume Control.
2. Adjust the Volume Controls.
3. Click the Close box.
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My sounds are cut off
Most audio cards can play only one sound at a time; therefore, other products with sound may interrupt sounds 
from this product. Some programs may take over the audio capability and prevent other Windows programs from
creating sounds.

If you think that you have another program that produces sounds which could interrupt sounds from this product,
do not run the two programs simultaneously.
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My sounds "skip"
If sound breaks up or "skips" periodically, it usually indicates that the CD-ROM drive does not meet the full MPC 
II (Multimedia PC - Level 2) specifications and needs to be upgraded.

You can continue to use your CD-ROM drive to run this program, but sound will continue to skip.

u CD-ROM Drive requirements:
Double-speed CD-ROM: This CD-ROM drive can transfer data from the CD-ROM at 300 KB per second 

while using less than 40% of the CPU bandwidth, and has an average seek time of less than 400 milliseconds.
MS-DOS CD-ROM Extensions (MSCDEX) version 2.2 or later.
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Checking and Changing Video Settings
Mastering Internet Development requires that your video driver supports a screen resolution of at least 640 x 
480 (the program will support higher screen resolutions, and we recommend you use 800 x 600 or greater). In 
addition, the program requires that your video driver is able to display 256 colors.

u To check video settings or change them:

1. Windows 95 users click here  to view Display properties.
2. Click the Settings tab.
3. Under Desktop Area, drag the slider.

Note    Your monitor and display adapter determine if you can change your screen resolution.

If your video driver is not working properly, please contact your video card manufacturer.
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The display driver supports less than 256
colors
Mastering Internet Development requires a video driver that supports a screen resolution of at least 640 x 480 
(although the program will support higher screen resolutions). In addition, the program requires that the video 
driver be able to display 256 colors.

u To check video settings or change them:

1. Windows 95 users click here  to view Display properties.
2. Click the Settings tab.
3. Under Desktop Area, drag the slider.

Note    Your monitor and display adapter determine if you can change your screen resolution.

If your video driver is not working properly, please contact your video card manufacturer.
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My machine "hangs"
If you use accelerated video drivers, video drivers with more than 256 colors, or high-resolution video drivers, 
the product may not display videos correctly. For example, you may see garbled images, or the product may 
stop running when you play a video.

If you encounter this, change to a standard video mode such as 640 x 480 resolution with 256 colors.

u To check video settings or change them:

1. Windows 95 users click here  to view Display properties.
2. Click the Settings tab.
3. Under Desktop Area, drag the slider.

Note    Your monitor and display adapter determine if you can change your screen resolution.
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When You Have a Question
If you have a question about Mastering Internet Development, first look in this Help file, or read the CD 
jewelcase booklet. If you cannot find the answer, contact the Microsoft Support Network.

Outside of the United States and Canada, contact Microsoft Product Support Services at the Microsoft 
subsidiary office that serves your area. For information about Microsoft subsidiary offices, see Product Support 
Worldwide.

The Microsoft Support Network
The Microsoft Support Network offers you a wide range of choices and access to high-quality, responsive 
technical support. Microsoft recognizes that support needs vary from user to user; the Microsoft Support 
Network allows you to choose the type of support that best meets your needs, with options that range from 
electronic bulletin boards to annual support programs. For information about support services in the United 
States and Canada, see Product Support Within the United States and Canada.. Services vary outside of the 
United States and Canada. In other locations, contact a local Microsoft subsidiary for information. The Microsoft 
Support Network is subject to Microsoft's then-current prices, terms, and conditions, and is subject to change 
without notice.
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Product Support Within the United States
and Canada
In the United States, no-charge support from Microsoft support engineers is available via a toll call between 6:00
A.M. and 6:00 P.M. Pacific time, Monday through Friday, excluding holidays. Call (206) 635-7033.

In Canada, support engineers are available via a toll call between 8:00 A.M. and 8:00 P.M. Eastern time, Monday 
through Friday, excluding holidays. Call (905) 568-3503.

When you call, you should be at your computer and have the appropriate product documentation at hand. Be 
prepared to give the following information:

1. The version number of the Microsoft product that you are using.
2. The type of hardware that you are using.
3. The exact wording of any messages that appeared on your screen.
4. A description of what happened and what you were doing when the problem occurred.
5. A description of how you tried to solve the problem.
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Electronic Services
Information and Electronic Services
No-cost and low-cost electronic information services are available 24 hours a day, 7 days a week, including 
holidays.

Microsoft FastTips
Call (800) 936-4200 on a touch-tone telephone. Receive automated answers to common technical problems, 
and access popular articles from the Microsoft Knowledge Base, all of which are delivered by recording or fax. 
You can use the following keys on your touch-tone telephone after you reach FastTips:

To advance to the next message, press *.
To repeat the current message, press 7.
To return to the beginning of FastTips, press #.

Microsoft Download Service
Access via modem, sample programs, device drivers, patches, software updates and programming aides (1200, 
2400, or 9600 baud; no parity; 8 data bits; 1 stop bit). In the United States, call (206) 936-6735.    In Canada, call 
(905) 507-3022.

Internet
Access the Microsoft Knowledge Base and Software Library. The Microsoft World Wide Web site is located at 
http://www.microsoft.com. The Microsoft Gopher site is located at gopher.microsoft.com. The Microsoft FTP site 
is located at ftp.microsoft.com and can be accessed via anonymous logon.

CompuServe, America Online, and GEnie
Access the Microsoft Knowledge Base, the Microsoft Software Library, and participate in Microsoft forums. On 
CompuServe, at any ! prompt, type go mskb to access the Microsoft Knowledge Base, go msl to access the 
Microsoft Software Library, and go microsoft to access Microsoft application forums. To access the Microsoft 
Knowledge Base on America Online, type go to microsoft in the America Online client application. To access 
the Microsoft Knowledge Base on Genie, type m505 at the Genie system prompt.
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Standard Support
In the United States, no-charge support from Microsoft support engineers is available via a toll call between 6:00
A.M. and 6:00 P.M. Pacific time, Monday through Friday, excluding holidays. 

For technical support for Mastering Internet Development, call (206) 635-7033. In Canada, support engineers 
are available via a toll call between 8:00 A.M. and 8:00 P.M. Eastern time, Monday through Friday, excluding 
holidays. Call (905) 568-3503. When you call, you should be at your computer and have the appropriate product 
documentation at hand.    Be prepared to give the following information:

1. The version number of the Microsoft product that you are using.
2. The type of hardware that you are using, including network hardware, if applicable.
3. The operating system that you are using.
4. The exact wording of any messages that appeared on your screen.
5. A description of what happened and what you were doing when the problem occurred.
6. A description of how you tried to solve the problem.
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Priority Support
The Microsoft Support Network offers priority telephone access to Microsoft support engineers 24 hours a day, 7
days a week, except holidays.

In the United States, call (900) 555-2000; $2 (U.S.) per minute, $25 (U.S.) maximum.    Charges appear on your 
telephone bill. Not available in Canada.

In the United States, call (800) 936-5700; $25 (U.S.) per incident, billed to your VISA, MasterCard, or American 
Express.

In Canada, call (800) 668-7975; $30 per incident, billed to your VISA, MasterCard, or American Express.
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Text Telephone
Microsoft text telephone (TT/TDD) services are available for the deaf or hard-of-hearing. In the United States, 
using a TT/TDD modem, dial (206) 635-4948 between 6:00 A.M. and 6:00 P.M. Pacific time, Monday through 
Friday, excluding holidays. In Canada, using a TT/TDD modem, dial (905) 568-9641 between 8:00 A.M. and 8:00
P.M. Eastern time, Monday through Friday, excluding holidays.
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Other Support Options
The Microsoft Support Network
The Microsoft Support Network offers annual support plans. For information, in the United States, contact the 
Microsoft Support Network Sales and Information group at (800) 936-3500 between 6:00 A.M. and 6:00 P.M. 
Pacific time, Monday through Friday, excluding holidays.    In Canada, call (800) 668-7975 between 8:00 A.M. 
and 8:00 P.M. Eastern time, Monday through Friday, excluding holidays.

Microsoft TechNet
Microsoft TechNet is the front-line resource for fast, complete answers to technical questions on Microsoft 
systems and desktop products. Information available on TechNet ranges from crucial data on client-server and 
workgroup computing, systems platforms, and database products, to the latest on support for Microsoft 
Windows- and Macintosh-based applications. As a TechNet user you receive:

® Twelve monthly compact discs containing the Microsoft Knowledge Base, Microsoft operating systems 
product resource kits, customer solutions, key Microsoft conference session notes, and other valuable 
information.

® Twelve monthly supplemental (drivers and patches) compact discs containing the Microsoft Software Library.
® A dedicated Microsoft TechNet forum on CompuServe (type GO TECHNET).
® WinCIM, a Windows-based program for accessing CompuServe.
® A 20% discount on Microsoft Press books.

For more information about Microsoft TechNet, in the U.S. and Canada, call (800) 344-2121, between 7:00 A.M. 
and 7:00 P.M. Central time, Monday through Friday. Outside the U.S. and Canada, contact your Microsoft 
Subsidiary, or call (303) 684-0914.

Microsoft Authorized Support Centers
Microsoft Authorized Support Centers (ACSs) are a select group of strategic support providers who offer high-
quality customized support services that span the complete systems life cycle of planning, implementation, and 
maintenance of your multivendor environment. Services include:

® On-site support
® Integration and implementation services
® Help desk services
® Hardware support
® Development resources
® and more.

Choosing an ASC allows you to work with one vendor for all of your technical support and service needs. You 
can also combine ASC services with your in-house help desk or Microsoft Support service option to best fit your 
information technology support needs.

For more information on the ASC program, in the U.S. call (800) 936-3500 between 6:00 A.M. and 6:00 P.M. 
Pacific time, Monday through Friday, excluding holidays. In Canada, call (800) 563-9048 between 8:00 A.M. and 
8:00 P.M. Eastern time, Monday through Friday, excluding holidays.
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Product Training and Consultation
Microsoft Solution Providers are independent developers, consultants, and systems analysts who offer fee-
based technical training and support, industry knowledge, objective advice, and a range of value-added services
to companies of all sizes. Solution Providers work with organizations to help implement computing systems that 
take advantage of today's powerful new technologies.

For the name of a Microsoft Solution Provider near you, in the U.S. call (800) 426-9400 between 6:30 A.M. and 
5:30 P.M. Pacific time, Monday through Friday, excluding holidays. In Canada, call (800) 563-9048 between 8:00
A.M. and 8:00 P.M. Eastern time, Monday through Friday, excluding holidays.
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Product Support Worldwide
If you are outside the United States and have a question about a Microsoft product, first:

1. Consult the documentation and other printed information included with your product.
2. Check online Help.
3. Consult electronic options such as CompuServe forums or bulletin boards, if available.
If you cannot find a solution, you can receive information about how to obtain product support by contacting the 
Microsoft subsidiary office that serves your country.

The Microsoft Support Network

The Microsoft Support Network, where available, offers you a wide range of choices and access to high quality, 
responsive technical support.    Microsoft recognizes that support needs vary from user to user; the Microsoft 
Support Network allows you to choose the type of support that best meets your needs, with options ranging from
electronic bulletin boards to annual support programs.    The Microsoft Support Network is subject to Microsoft's 
then-current prices, terms, and conditions that are in place in each country at the time the services are used, and
is subject to change without notice.

Calling a Microsoft Subsidiary Office

When you call, you should be at your computer and have the appropriate product documentation at hand. Be 
prepared to give the following information:

1. The version number of the Microsoft product that you are using.
2. The type of hardware that you are using, including network hardware, if applicable.
3. The operating system that you are using.
4. The exact wording of any messages that appeared on your screen.
5. A description of what happened and what you were doing when the problem occurred.
6. A description of how you tried to solve the problem.
Microsoft subsidiary offices and the countries that they serve are listed below. If there is no Microsoft office in 
your country, please contact the establishment from which you purchased your Microsoft product.

Argentina
Australia
Austria
Europe
Belgium
Bolivia
Brazil
Canada
Caribbean
Czech Republic
Chile
Colombia
Denmark
Dubai
Equador
England
Finland
France
French Polynesia



Germany
Greece
Hong Kong
Hungary
Indonesia
India
Ireland
Israel
Italy
Japan
Korea
Liechtenstein
Luxembourg
Malaysia
México
Netherlands
New Zealand
Northern Ireland
Norway
Papua New Guinea
Paraguay
Philippines
Poland
Portugal
Republic of China
Republic of Ireland
Russia
Scotland
Singapore
Slovenia
Slovak Republic
South Africa
Spain
Sweden
Switzerland
Turkey
United Kingdom
Uruguay
Venezuela
Wales
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Your computer uses a piece of hardware called a video card (or video display adapter) to display images on your
video monitor. Your computer uses a special piece of software called a "video driver" to communicate with your 
video card (and vice versa).



Video color-depth refers to the number of colors that your video driver is capable of displaying simultaneously on
your monitor.    The maximum number of colors that you can display is determined by a combination of two 
factors: the amount of video RAM (or VRAM) that your video card has onboard, and the screen resolution.

Most video cards can display 256 colors at a screen resolution of 640 x 480. Greater color-depth or greater 
screen resolution with 256 or more colors may require additional VRAM.

Color-depth is referred to in terms of "bits" (e.g. 8-bit). The number of colors you see is equal to the number 2 to 
the power of the number of bits to which your color-depth is set. The following is a list of the most common color-
depths and the number of colors that they represent:

2 bit 4 colors
4 bit 16 colors
8 bit 256 colors
16 bit 65,536 colors (often referred to as 64K or 

64,000 colors)
24 bit 16,777,216 colors (often referred to as 16M 

or 16 million colors)

DPI = Dots per inch



Microsoft de Argentina S.A.
Customer Service: (54) (1) 819-1900
Fax: (54) (1) 819-1921
Technical Support for Development Tools: (54) (1) 819-1900
Technical Support for Windows 95: (54) (1) 314-0560 



Microsoft Pty. Ltd.
Installation Support: (61) (02) 870-2870
Fax: (61) (02) 805-0519
Bulletin Board Service: (61) (02) 878-5200
Technical Support: (61) (02) 870-2131
Sales Information Centre: (61) (02) 870-2100



Microsoft Ges.m.b.H.
Phone: 0222-68 7607
Fax: 0222-68 16 2710
Information: 0660-6520
Prices, updates, etc.: 0660-6520
Windows installation: 0660-6520
CompuServe: GO MSEURO (Microsoft Central Europe)
General Information about the Microsoft Support Network in Central Europe:
Fax: 0049/2622/167006



Technical support: 0660-6511



Microsoft Belgium
Phone: (32) (2) 730-3911
Fax: (32) (2) 726-9609
Technical Support:
    (32) (2) 513-3274 (Dutch speaking)
    (32) (2) 502-3432 (English speaking)
    (32) (2) 513-2268 (French speaking)
Bulletin Board:
      (32) (2) 726-8545
      (14400/1200/2400/9600 bd, 8N1, ANSI)



(Argentina)
Microsoft de Argentina S.A.
Customer Service: (54) (1) 819-1900
Fax: (54) (1) 819-1921
Technical Support for Development Tools: (54) (1) 819-1900
Technical Support for Windows 95: (54) (1) 314-0560 



Microsoft Informatica Ltda.
Phone: (55) (11) 514 -7100
Fax: (55) (11) 514 - 7106/514-7107
Technical Support Phone: (55) (11) 871-0090
Technical Support Fax: (55) (11) 262-8638
Technical Support Bulletin Board Service: (55) (11) 872-4106
Technical Support Help by Fax (55) (11) 871-4701 



Microsoft Canada, Inc.
Head Office Phone: (905) 568-0434
Customer Support Centre: (800) 563-9048
MS Office Technical Support Phone: 1 (905) 568-2294
Priority Support Information: 1 (800) 668-7975
Text Telephone (TT/TDD) 1 (905) 568-9641
Technical Support Bulletin Board Service: 1 (905) 507-3022 



Microsoft Caribbean, Inc
Tel: (809) 273-3600
Fax: (809) 273-3636
Technical Support: (214) 714-9100



Microsoft Chile S.A.
Phone: (56) (2) 330-6000
Fax: (56) (2) 330-6190
Customer Service: 56) (2) 800-213121
Personal Operating System and Applications:
Phone: (56) (2)-330-6222
Fax: (56) (2) 341-1439 



Microsoft Colombia
Tel: (571) 618 2245
Soporte Tecnico: (571) 618 2255
Fax:(571) 618 2269



Microsoft
Panská 6
11000 Praha 1
Phone (+42) (2) 2423-7089 or 2423-4325
Fax: (+42) (2) 2423-4343
Technical Support:
Phone: (+42) (2) 2451-0554 or 53 52 56 (Win95 only)



Microsoft Denmark AS
Phone: (45) (44) 89 01 00
Technical Support: (45)    (44) 89 01 11
Microsoft Sales Support: (45) (44) 89 01 90
Microsoft BBS:
      (45) (44) 66 90 46
      (Document 303030 in FaxSvar contains detailed instructions)
Microsoft FaxSvar: (45) (44) 89 01 44



Microsoft Middle East
Phone: (971) 4 513 888
Fax: (971) 4 527 444



Microsoft Corporation Equador S.A.
Phone: (593) 2 460-447, (593) 2 460-451
Customer Service: (593) 2 460-453, (593) 2 460-458
Technical Support: (593) (2) 463-094



(United Kingdom)
Microsoft Limited
Phone: (44) (01734) 27-0000, (01734) 27-0001
Fax: (01734) 27-0002
Pre-Sales Information: (0345) 00-2000
Upgrades & Registration: (44) (816) 14-8000
Bulletin Board Service:
      (01734) 27-0065 (up to 14.4Kbaud, n, 8, 1)
Fax Information Service (01734) 27-0080
Customer Support: (01734) 27-1000
Developer Support: (01734) 27-1414
Advanced Systems Support: (01734) 27-1007 



Microsoft OY
For Technical Support, please contact your local dealer.
Phone: (0358) (90) 525 502 500
Microsoft FaxSvar: (46) (0)8 752 29 00
      (Information in Swedish and English)
Microsoft BBS:
      (46) (0) 8 750 47 42
      (Information in Swedish and English)
Microsoft MSDL: 90-455 03 66
Microsoft FastTips: 90-525 502 550



Microsoft France
Phone: (33) (1) 69-86-46-46
Telex: MSPARIS 604322
Fax: (33) (1) 64-46-06-60
Technical Support Phone: (33) (1) 69-86-10-20
Technical Support Fax: (33) (1) 69-28-00-28
Fax Information Service: (33) 36-70-13-13



(France)
Microsoft France
Phone: (33) (1) 69-86-46-46
Telex: MSPARIS 604322
Fax: (33) (1) 64-46-06-60
Technical Support Phone: (33) (1) 69-86-10-20
Technical Support Fax: (33) (1) 69-28-00-28
Fax Information Service: (33) 36-70-13-13



Microsoft GmbH
Phone: 089-3176-0
Telex: (17) 89 83 28 MS GMBH D
Fax: 089-3176-1000
Information: 089-3176 1199
Prices, updates, etc.: 089-3176 1199
CompuServe: GO MSEURO (Microsoft Central Europe)
Bulletin board, device drivers, tech notes:
      Btx: *microsoft# or *610808000#
Standard Support: Installation and Handling
Windows 95: 089 / 31 76 - 11 15
General information about the Microsoft Support Network in Central Europe:
FAX: 02622/167006



Microsoft Hellas, S.A.
Phone: (30) 1 6806-775 through (30) 1 6806-779
Fax: (30) 1 6806 780



Microsoft Hong Kong Limited
Microsoft Hong Kong Limited Phone (852)-2804-4200
Microsoft Hong Kong Limited Fax (852)-2560-2217
Product Support Services (852)-2804-4222
PSS Faxback Service: (852)-2535-9293
Microsoft Club Upgrade Centre: (852)-2880-5085
Microsoft Club Member Hotline: (852)-2516-5113
Technical Support: (852)-2804-4222



Microsoft Kft.
Phone: (+36) (1) 268-1668
Fax: (+36) (1) 268-1558
Microsoft Hotline/Customer Service: (+36) (1) 2MS-INFO (267-4636)



(United Kingdom)
Microsoft Limited
Phone: (44) (01734) 27-0000, (01734) 27-0001
Fax: (01734) 27-0002
Pre-Sales Information: (0345) 00-2000
Upgrades & Registration: (44) (816) 14-8000
Bulletin Board Service:
      (01734) 27-0065
      (up to 14.4Kbaud, n, 8, 1)
Fax Information Service (01734) 27-0080
Customer Support: (01734) 27-1000
Developer Support: (01734) 27-1414
Advanced Systems Support: (01734) 27-1007 



Microsoft India
Phone: (01) (91) 646 0694, 646 0767, 646 0813
Fax: (01) (91) 646-0813



Indonesia - Jakarta
Technical Support
Phone: (6221) 572-1060
Fax: (6221) 573-2077



Microsoft Israel Ltd.
Phone: 972-3-613-0833
Fax: 972-3-613-0834



Microsoft SpA
Phone: (39) (2) 7039-21
Fax: (39) (2) 7039-2020
Microsoft by Fax (Fax-on-demand service):
      (39) (2) 70-300-703
Customer Service (New product info, product literature):
      (39) (2) 70-398-398
Dealer Support (Customer Service for Dealers only):
      (39) (2) 70-398-388
Bulletin Board: (39) (2) 7030-0102
Technical Support: (39) (2) 70-398-351



Microsoft Company Ltd.
Phone: (81) (3) 5454-8000
Fax: (81) (3) 5454-7972
PSS Technical Support Fax: (81) (3) 5454-7955
Customer Service Phone (Version Upgrade/Registration)
Phone: (81) (3) 5454-2305
Fax: (81) (3) 5454-7952
Channel Marketing (Pre-sales Product Support) Information Center
Phone: (81) (3) 5454-2300
Fax: (81) (3) 5454-7951



Microsoft CH
Phone: (82) (2) 531-4500
Fax: (82) (2) 555-1724
Technical Support: (82) (2) 531-4800
Windows Tech Support Line: (82) (2) 563-0054
Technical Support Fax: (82) (2) 531-4600
Technical Support Bulletin Board Service: (82) (2) 538-3256



(German speaking Switzerland)
Microsoft AG
Phone: 01-839 61 11
Fax: 01-831 08 69
Prices, Updates: 01-839 61 11
Documentation: Phone: 155 59 00
Fax: 064-224294,
Microsoft Info-Service
Postfach, 8099 Zürich
Windows, Windows for Workgroups, Printing System: 01/342-4085
General information about the Microsoft Support Network in Central Europe:
FAX: 0049/2622/167006



Microsoft Luxemborg
Phone: +32 2 730 39 11
Fax: +32 2 726 96 09
CompuServe: (32) 2-2150530 (GO MSBEN)
Technical Support:
+32 2 513 32 74 (Dutch speaking)
+32 2 502 34 32 (English speaking)
+32 2 513 22 68 (French speaking)
Bulletin Board:
      +32 2 726 85 45
      (14400/1200/2400/9600 bd, 8N1, ANSI)



Microsoft (Malaysia) Sdn Bhd:
Phone: (60-3) 794-9595
Fax : (60-3) 791-6080



Microsoft México, S.A. de C.V.
Phone: (52) (5) 325-0910
Fax: (52) (5) 280-7940
Customer Service: (52) (5) 325-0911
Technical Support: (52) (5) 325-0912 Standard Support
Technical Support: (52)(5) 237-4800 Developers Tools and Advanced Systems
Fast Tips: (52)(5) 237-4894 (24 hours x 365 days service)
Bulletin Board Service:
      (52) (5) 628-6200
      (2400s/14400k baud, 8 bits, No parity, 1 stop bit, ANSI terminal emulation)
      (52) (5) 628-6202
      (14400k baud, 8 bits, No parity, 1 stop bit, ANSI terminal emulation)
      User: MSMEXICO, NO Password



Microsoft BV
Phone: 023-5689189
Customer Service: 023-5677700
CompuServe: 020-6880085 (GO MSBEN)
Technical Support:
023-5677877 (Dutch speaking)
023-5677853 (English speaking) 
Bulletin Board:
      023-5634221
      (1200/2400/9600 bd, 8N1, ANSI)



Microsoft New Zealand Ltd.
Phone: 64 (9) 358-3724
Fax: 64 (9) 358-3726
Technology Link Centre (Technical Support):
Phone: 64 (9) 357-5575
Fax: 64 (9) 307-0516 and 357-5577 



(United Kingdom)
Microsoft Limited
Phone: (44) (01734) 27-0000, (01734) 27-0001
Fax: (01734) 27-0002
Pre-Sales Information: (0345) 00-2000
Upgrades & Registration: (44) (816) 14-8000
Bulletin Board Service:
      (01734) 27-0065
      (up to 14.4Kbaud, n, 8, 1)
Fax Information Service (01734) 27-0080
Customer Support: (01734) 27-1000
Developer Support: (01734) 27-1414
Advanced Systems Support: (01734) 27-1007 



Microsoft Norway AS
Phone: (47) (22) 02 25 00
Microsoft Sales Support: (47) (22) 02 25 80
Microsoft BBS:
      (47) 22 18 22 09
      (Document 404040 in FaxSvar contains detailed instructions)
Microsoft FaxSvar: (47) (22) 02 25 70
Technical Support: (47) (22) 02 25 50
Microsoft MSDL: 22 18 22 09
Microsoft FastTips: 22 02 25 70



(Australia)
Microsoft Pty. Ltd.
Installation Support: (61) (02) 870-2870
Fax: (61) (02) 805-0519
Bulletin Board Service: (61) (02) 878-5200
Technical Support: (61) (02) 870-2131
Sales Information Centre: (61) (02) 870-2100



(Argentina)
Microsoft de Argentina S.A.
Customer Service: (54) (1) 819-1900
Fax: (54) (1) 819-1921
Technical Support for Development Tools: (54) (1) 819-1900
Technical Support for Windows 95: (54) (1) 314-0560 



Microsoft Philippines
Phone: (632) 811-0062
Technical Support:
Phone : (632) 892-2295/2495
Fax: (632) 813-2493



Microsoft Sp.z o.o.
ul. Grzybowska 80/82
00-844 Warszawa
Phone: (+48) (22) 661-5405
Fax: (+48) (22) 661-5434
Technical Support:
Phone: (+48) (22) 621-6793 or (+48) (71) 441-357



MSFT, Lda.
MSFT, Lda.Phone: (351) (1) 440-9200
Fax: (351) (1) 441-2101
Technical Support:
Standard Support (All Clusters): (351) (1) 440-9280/1/2/3
Fax : (351) (1) 441-1655



Microsoft Taiwan Corp.
Phone: (886) (2) 504-3122
Fax: (886) (2) 504-3121
Technical Support : (886) (2) 508-9501



Microsoft A/O
Leningradsky Prospekt80
125178 Moscow
Phone: (+7) (502) 224 50 46
Fax: (+7) (502) 224 50 45



(United Kingdom)
Microsoft Limited
Phone: (44) (01734) 27-0000, (01734) 27-0001
Fax: (01734) 27-0002
Pre-Sales Information: (0345) 00-2000
Upgrades & Registration: (44) (816) 14-8000
Bulletin Board Service: 
      (01734) 27-0065
      (up to 14.4Kbaud, n, 8, 1)
Fax Information Service (01734) 27-0080
Customer Support: (01734) 27-1000
Developer Support: (01734) 27-1414
Advanced Systems Support: (01734) 27-1007 



(United Kingdom)
Microsoft Limited
Phone: (44) (01734) 27-0000, (01734) 27-0001
Fax: (01734) 27-0002
Pre-Sales Information: (0345) 00-2000
Upgrades & Registration: (44) (816) 14-8000
Bulletin Board Service:
      (01734) 27-0065
      (up to 14.4Kbaud, n, 8, 1)
Fax Information Service (01734) 27-0080
Customer Support: (01734) 27-1000
Developer Support: (01734) 27-1414
Advanced Systems Support: (01734) 27-1007 



Microsoft Singapore Pte Ltd
Phone: (65) 337-6088
Fax : (65) 337-6788
Customer Services Phone: (65) 433-5488
Customer Services Fax: (65) 339-9958
Product Support Phone: (65) 337-9946
Product Support Fax: (65) 337-6700



Microsoft d.o.o.
Technical Support
Phone: (+386) (61) 1881 133
Fax: (+386) (61) 1881 137
Technical Support: (+386) 61 123 23 54 or (+386) 64 331 020



Microsoft
Panská 6/ I
11000 Praha 1
Phone (+42) (2) 2423 7089 or 2423 4325
Fax: (+42) (2) 2423 4343
Technical Support:
Phone: (+42) (7) 312083



Microsoft South Africa
Phone: (27) 11 445 0000
Fax: (27) 11 445 0045 or (27) 11 445 0046
Technical Support (Toll Free): 0 802 11 11 04
(Toll): (2) 11 445 0100
Customer Service Centre: (27) 11 445 0145



Microsoft Iberica SRL
Phone: (34) (1) 807 99 99
Fax: (34) (1) 803 8310
Technical Support: 91 807 99 60
Customer Service: (34) (1) 804 0096
Fax Back telephone: 91 804 00 96



Microsoft AB
Phone: (46) (08) 752 09 29
Sales Support: (46) (8) 752 56 30
Microsoft FaxSvar: (46) (0)8 752 29 00
Microsoft BBS:
      (46) (8) 750 47 42
      (Document 202020 in FaxSvar contains detailed instructions)
Information on Technical Support: (46) (8) 752 09 29
Microsoft MSDL: 08-750 47 42
Microsoft FastTips: 08-752 29 00



Microsoft AG
Phone: (01) 839-6111
Fax: (01) 831-0869
Prices, updates, etc.: (01) 839-6111
CompuServe: GO MSEURO(Microsoft Central Europe)
Documentation:
Phone: 155-5900
Fax: (064) 224-294,
Microsoft Info-Service, Postfach, 8099 Zürich
Windows, Windows for Workgroups, Printing System: (01) 342-4085
Technical support (French speaking): (022) 738-9688
General information about the Microsoft Support Network in Central Europe:
FAX: (0049) (2622) 167-006



Microsoft Turkey
Phone: (90) 212 258-5998
Fax: (90) 212 258-5954



Microsoft Limited
Phone: (44) (01734) 27-0000, (01734) 27-0001
Fax: (01734) 27-0002
Pre-Sales Information: (0345) 00-2000
Upgrades & Registration: (44) (816) 14-8000
Bulletin Board Service:
      (01734) 27-0065
      (up to 14.4Kbaud, n, 8, 1)
Fax Information Service (01734) 27-0080
Customer Support: (01734) 27-1000
Developer Support: (01734) 27-1414
Advanced Systems Support: (01734) 27-1007 



(Argentina)
Microsoft de Argentina S.A.
Customer Service: (54) (1) 819-1900
Fax: (54) (1) 819-1921
Technical Support for Development Tools: (54) (1) 819-1900
Technical Support for Windows 95: (54) (1) 314-0560 

(Uruguay)
Technical Support: (598) (2) 77-4934 



Corporation MS 90 de Venezuela S.A.
General Information:
    (582)-993-6156
    (582)-91-4739
    (582)-91-3342
Fax: (582)-92-3835
Technical Support:
    (582)-993-5249
    (582)-993-9256 



(United Kingdom)
Microsoft Limited
Phone: (44) (01734) 27-0000, (01734) 27-0001
Fax: (01734) 27-0002
Pre-Sales Information: (0345) 00-2000
Upgrades & Registration: (44) (816) 14-8000
Bulletin Board Service:
      (01734) 27-0065
      (up to 14.4Kbaud, n, 8, 1)
Fax Information Service (01734) 27-0080
Customer Support: (01734) 27-1000
Developer Support: (01734) 27-1414
Advanced Systems Support: (01734) 27-1007



Meet the Microsoft Mastering Series
Mastering Internet Development is one in a series of CD-ROM-based training programs. The other Mastering 
Series titles currently available are:

Mastering Microsoft Visual FoxPro
Mastering Microsoft Visual Basic 4.0
Mastering Microsoft Visual C++ 4
Mastering Microsoft Access Programming
Mastering Microsoft Exchange Development

The Microsoft Mastering Series titles are content-rich, self-paced, interactive CD-ROM-based learning tools that 
are designed to help you quickly master Microsoft development tools. The courses combine high-level technical 
content with an intuitive learning methodology, so you can learn in the way that best suits your schedule and 
study habits.

All Mastering titles include interactive lessons, narrated demonstrations, hands-on labs, sample code, and a 
library of reference material to supplement courses and exercises. A flexible browsing and searching system 
allows you to navigate directly to the course material or library resources that you need.

Most of the Mastering Series courses are Microsoft Official Curriculum and can be used to gain the skills 
necessary for Microsoft Certification. Microsoft Mastering Series products are not introductions to programming. 
It is assumed that you have experience using Microsoft development tools to create solutions for Microsoft 
Windows.

Related Topics



Take the Tour
The best way to familiarize yourself with Mastering Internet Development is to take a short multimedia tour of the
application. The Tour is accessible from the Help menu and from the Welcome screen. You can take the entire 
Tour, or view one part at a time.

Here's a brief description of Tour options:

Complete Tour. The entire tour includes all the parts listed below.
Getting Around. Introduces you to the contents of the application and shows you how to navigate and 

locate information.
Finding Information. Describes the Index and full-text search feature.
Keeping Notes and Bookmarks. Tells you how to add bookmarks and take full advantage of the Notebook 

tool.
Customizing How You Work. Discusses the various ways you can customize how you work with the 

application.



System Requirements
To run Mastering Internet Development , you need:

® Personal computer with a 486DX or higher processor running Microsoft Windows 95
® Microsoft Internet Explorer version 3.0 or later
® 8 megabytes (MB) of memory (16 MB recommended for Windows 95)
® 10 MB available hard disk space
® MPC2-compatible CD-ROM drive
® Super VGA or higher resolution video adapter capable of displaying 256 colors or more
® Microsoft Mouse or compatible pointing device
® MPC2-compatible audio board (required for audio and video instruction)
® A modem and an account with an Internet service provider or online service (required to access information 

referenced on the World Wide Web).

Note    To run the lab exercises, you must install Microsoft FrontPage 1.1 or one of the Microsoft Office Internet 
Assistants; Microsoft Visual C++ or Microsoft Visual Basic; and Microsoft Internet Information Server version 1.0 
or later (requires Windows NT version 3.51 or later).



Use the Navigation Area
The Navigation Area occupies the left pane of the Main Viewer and is used to navigate through the application 
content. From the menu at the top of the Navigation Area, you can choose to view a component of the Entire 
Course or a section of the Library to be displayed in the Table of Contents.

Use the Navigation Area toolbar buttons to view the Table of Contents or to find information, as shown below.

Contents. Displays entries for the Course components or Library sections.

Index. Displays Index entries related to particular topics in the Course and the Library.

Find. Displays the Find pane, where you can search for a word or topic.

The Navigation Area is separated from the Topic Area (the right side of the Main Viewer) by a sizing border that 
you can drag to change the relative size of both panes.

Related Topics



The Course Components are:

Entire Course. This option displays the chapters for the entire course in the Table of Contents, and includes
the components listed below.

Labs Only. Labs are exercises that you can work through to master the material covered in the chapter.
Multimedia Only. Demonstrations, animations, and expert points of view are used to explain or illustrate 

programming concepts and techniques.
Sample Code Only. Sample code is provided to illustrate the material covered in the chapters and labs.
Self-Checks Only. You can use the Self-Check questions and answers at the end of each chapter to test 

your understanding of the material covered in the chapter.



View Content in the Topic Area
The right pane of the Main Viewer is called the Topic Area. When you select a topic in the Navigation Area (the 
left pane), the text and associated media displays in the Topic Area. Here's what you can view in the Topic Area:

Course or Library selections from the Table of Contents
A topic selected from the Notebook
A topic selected from the History window
Items listed in the Index
Search results from your Find requests

When you click a topic in the Navigation Area, the information is displayed in the Topic Area. You can also use 
the buttons on the toolbar at the bottom of the Topic Area to move backward and forward through content 
information, or to jump to information that is related to the currently displayed topic.

You can select text displayed in the Topic Area to copy to the Clipboard. You can also print the entire topic.

To change the relative size of both panes, drag the splitter bar between the two panes.

Related Topics



Display Multimedia and Additional 
Information
Throughout Mastering Internet Development, you will find multimedia icons that you can click to:

View various forms of additional information, such as narrated demonstrations and points of view, 
animations, graphics, sample code, tips, and more.

Execute programs, including Setup for various Microsoft tools.
Launch Help files.
Launch Internet Explorer and jump to a specific Uniform Resource Locator (URL).

Here's a list of the icons that you'll see. Click an icon to obtain a more detailed description.

Animation Introduction. Each chapter starts with 
an animated introduction describing what you can 
expect to learn in the chapter. Additional animations 
in the course illustrate complex technical concepts.

Demonstration. Narrated demonstrations help you 
learn by watching and listening as a developer takes 
you through the steps of a procedure.

Executable. Execute a program.

Help. Launch Help files.

Point of View. Get advice from an expert to help you
master concepts and techniques.

Graphic. View technical illustrations and diagrams.

Internet. Launch Internet Explorer and jump to a 
specific URL on the Internet.

Sample Code. View a pop-up window of sample 
code.

Self-Check Answer. Each chapter provides several 
Self-Check questions and one answer. Click this icon
to view the answer to a question.

Tip. View a helpful tip.

Related Topics



Choose a Display Mode
You can view the Table of Contents, Index, or Find features of the Navigation Area in the left pane, while 
displaying information in the Topic Area in the right pane. Or, you can hide the Navigation Area and view just the 
Topic Area.

To display both areas, do one of the following:

Click the Navigation & Topic button on the toolbar.

From the View menu, click Navigation & Topic.

Press CTRL+A.
Point to the left pane, click the right mouse button, and click Navigation & Topic from the shortcut 

menu.
To display only the Topic Area, do one of the following:

Click Topic Only on the toolbar.

From the View menu, click Topic Only.

Press CTRL+O.
Point to the left pane, click the right mouse button, and click Topic Only from the shortcut menu.

Related Topics



Introducing the Course
In the Course, you will learn how to create static and active content for the World Wide Web using Microsoft 
Internet technologies and tools.

The Course includes an extensive assortment of labs that give you hands-on experience with the skills learned 
in the chapters. Each lab consists of one or more exercises that focus on how to use the information contained 
in the associated chapter. At any time, you can review the solutions to understand the authors' approach.

The Course also includes narrated demonstrations and animations, points of view, sample code, tips, and more. 
You can test your understanding by answering the Self-Check questions.

The Library contains numerous additional technical references and resources, including Articles and 
Whitepapers, Knowledge Base articles, Books, pointers to relevant World Wide Web sites, useful tools that you 
can install from the CD-ROM, and more.

Taking the Tour is the best way to learn more about the content and how to navigate. The Tour is offered from 
the Help menu and the Welcome screen.

Related Topics



An Overview of Course Content
Click a button below for a description of each chapter in the Course:

1 Architecture of the Internet
2 Installing an Internet Server
3 Authoring a Static Web Page
4 Adding Controls and Objects to a Web Page
5 Adding Client-Side Scripts with VBScript
6 Communicating with the Internet Server
7 Enabling Data Access Using ODBC
8 Automating Internet Explorer
9 Adding E-mail Capabilities to an Application
1
0

Developing Server-Side Extensions

You can take the Course in any order that you choose-start at the beginning, jump into the middle, or read only 
those topics that interest you.

Related Topics



Chapter 1 introduces you to the resources and technologies found on the Internet. This chapter also introduces 
the architecture of the Internet and of the World Wide Web, and shows how to use Internet services to send and 
receive various kinds of information.



Chapter 2 discusses the reasons for using and maintaining an Internet server. It also helps you make decisions 
about what type of Internet server you should use for publishing and testing documents on the Internet or on an 
intranet. This chapter also shows how to install, configure, and extend the Microsoft Information Server.



Chapter 3 explains different ways you can present static information in a World Wide Web site. It introduces 
Hypertext Markup Languge (HTML), the language behind a Web page, and shows you how to use Internet 
Assistant for Microsoft Word to build a static Web page. The chapter also shows how to add advanced features-
such as frames and image maps-to your Web page.



Chapter 4 introduces the concept of an active HTML page. It explains how to add standard controls, ActiveX 
controls, and Java applets to your Web page.



Chapter 5 explains the role of client-side scripting in the creation of active Web page content. It shows how to 
use VBScript to create event procedures for objects on the Web page, as well as set properties and call 
methods for these objects. You will also learn about the objects that are exposed by the Internet Explorer object 
model for scripting.



Chapter 6 explains how to call resources on the Internet server to extend the activity of Web pages. It also 
explains the various ways that server extensions are called from a Web page and shows some sample server 
extensions that you can use in your own Web pages.



Chapter 7 explains how to use the Internet Database Connector ISAPI extension to add database connectivity 
to your Web site. The chapter explains how to pass a simple SQL query to the server, as well as how to pass a 
SQL query with parameters.



Chapter 8 introduces two ways to add Internet-awareness to your Microsoft Visual Basic application: as an 
ActiveX component running as a separate application, and as an ActiveX control contained within your 
application.



Chapter 9 shows how to add mail capabilities to an application developed with Microsoft Visual Basic or 
Microsoft Visual C++ using Simple MAPI and the Messaging Library.



Chapter 10 explains how to use Microsoft Visual C++ to build your own custom ISAPI extensions and filters.



Course Components
Mastering Internet Development consists of components that can be accessed from within the Course or Library 
content, or directly from the menu at the top of the Navigation Area. The Course components include:

Entire Course
Labs
Multimedia
Sample Code
Self-Checks

Within the Course chapters, you'll also find:

Executables
Help Files
Graphics
Internet Jumps
Tips

Related Topics



Multimedia demonstrations, animations, and points of view illustrate and help you master programming 
concepts and techniques. You can jump to a list of demonstrations and animations, or points of view from the 
menu at the top of the Navigation Area. To launch a demonstration, animation, or point of view click your choice 
from the list.

To launch a demonstration from within the Course, click the Demonstration icon.

To launch an animation from within the Course, click the Animation icon.

To launch a point of view from within the Course, click the Point of View icon.

Note    Select Closed Caption from the View menu (or press CTRL+S) to view the text of the audio.

Each pop-up window has a control that allows you to play, pause, or jump to another location in the media file.



Executable files can be launched from within Mastering Internet Development.

To launch an executable file, click the Executable icon.

Follow the installation instructions specific to the Setup program you have executed.



Help files can be launched from within Mastering Internet Development.

To launch a Help file, click the Help icon.

Note    The Mastering Internet Development Help file is launched from the toolbar or Help menu.



Graphics are provided to illustrate important information described in the Course. You'll see three types of 
graphics:

Standard in-line graphics.

In-line graphics with hot spots you can click to view further information.

Pop-up graphics. Click the Graphics icon from within the Course to view these graphics. Graphics displayed in 
this window can be displayed in two sizes; click the graphic to expand or reduce the window.

You can print or copy a graphic to the Clipboard by using the toolbar or menu commands above the Navigation 
Area.



Launch Internet Explorer and jump to a specific URL on the Internet.

To launch Internet Explorer and jump to the specified Web page, click the Internet Jump icon and then click OK 
in the dialog box.

Note    The first time you launch Internet Explorer from within Mastering Internet Development, a dialog box 
appears informing you that you are about to launch Internet Explorer. If you do not want this prompt to appear 
each time you launch Internet Explorer, you can turn off this option by clicking "View this dialog when launching 
Internet Explorer 3.0."

You can browse the Web site you jumped to, or surf the Internet by entering other URLs. To return to Mastering 
Internet Development, minimize or close Internet Explorer.



Labs in each chapter illustrate programming concepts and techniques. You can jump to the lab exercises from 
the Labs Only menu option at the top of the Navigation Area, or from within the Course. (In the Course, labs and 
solutions appear after the chapter section they are associated with.)

Each lab has associated project, solution, and demonstration files. You can review the complete solution for 
each lab from within the Course, or from the Demonstrations and Animations Only menu option.



A list of Sample Code is available from the menu at the top of the Navigation Area. To display sample code in 
the Topic Area, select the chapter or lab and click your choice from the list of sample code.

Or, you can view sample code by clicking the Sample Code icon from within the chapters or labs in the Course.

The Sample Code window opens to the same size and location used when last closed. You can resize the 
window by dragging its borders.

You can select sample code to copy it to the Clipboard. Or, you can print or copy all of the sample code that is 
displayed in the window. Simply right-click the mouse to display the shortcut menu, and then click Print or Copy.



Test your understanding of the Course material by answering the Self-Check questions. You can view a list of 
the Self-Check questions from the menu at the top of the Navigation Area, or at the end of each chapter in the 
Course. Each chapter offers several questions with one correct answer for each.

To view an answer, click the Answer icon.

The Self-Check Answer window opens to the same size and location used when last closed. You can resize the 
window by dragging its borders.

You can print or copy an answer to the Clipboard. Simply right-click the mouse to display the shortcut menu, and
then click Print or Copy.

Note    You can print or copy the questions displayed in the Topic Area by clicking the Print icon on the main 
toolbar, or by using the shortcut menu in the Topic Area.



Tips are provided throughout the chapters.

To view a tip, click the Tip icon from within the Course.

The Tip window opens to the same size and location used when last closed. You can resize the window by 
dragging its borders.

You can select a portion of the tip to copy it to the Clipboard. Or, you can print or copy the entire tip. Simply right-
click the mouse to display the shortcut menu, and then click Print or Copy.



Put the Index to Work
To use the Navigation Area to search through an index of the Entire Course and Library, do one of the following:

Click the Index button on the Navigation Area toolbar.

From the View Menu, click Index.

Press CTRL+I.
Point to the Navigation Area, click the right mouse button, and then click Index from the shortcut 

menu.
To Use the Index:

Click the text box and type the first few letters of the word that you want. The Index will scroll to the closest entry 
and list related topics in the box at the bottom. Click an Index entry to display the topic in the Topic Area.

Related Topics



Use "Find" to Refine Your Search
To use Find to search for a word or phrase, do one of the following:

Click Find on the Navigation Area toolbar.

From the View Menu, click Find.

Press CTRL+F.
Point to the Navigation Area, click the right mouse button, and then click Find from the shortcut 

menu.
You can type a word or phrase, or select a previous search string from the drop-down list. To search for a 
phrase, enclose the phrase in quotation marks. You can also use Boolean operators to refine your search.

Related Topics



Using Boolean Operators
Mastering Internet Development supports the following Boolean operators in the Find tool.

Operator Description Example

* Matches any 
number of 
characters in a 
word

valid* finds valid, validate, 
validation

AND
+ (plus 
sign)

The logical 
AND ( + ) 
operator finds 
only topics that 
contain all of 
the strings

language AND logic finds 
only topics that contain both
words

OR
| (pipe)

The logical OR 
( | ) operator 
finds topics that
contain any of 
the listed 
strings

language OR logic finds 
topics that contain either 
word

NOT
- (minus)

The logical 
NOT ( - ) 
operator finds 
only topics that 
do not contain 
the string

language NOT logic finds 
topics that contain the word 
language and do not 
contain the word logic

NEAR The NEAR 
operator finds 
only those 
topics within 
eight words

save NEAR print finds only 
those topics that contain the
two words within eight 
words from each other

Multiple operators can be combined in a single search. The search string is evaluated from left to right. You can 
also enclose a phrase in quotation marks to search for that exact phrase, rather than the individual words within 
it. 

Press ENTER to run the search. When the results list appears, click a topic to view it in the Topic Area. The word
or phrase for which you searched is highlighted in the displayed topic.



Check Out the Glossary
Glossary terms and definitions are provided in two ways: 

Click the Glossary button on the toolbar to open the Glossary Help file and search for a word or phrase.

Click any word or phrase in the Course that is underlined magenta text to display the associated 
glossary definition.

Related Topics



Revisiting Topics Using the History 
Window
To browse through a list of previously visited topics, open the History window by choosing History from the 
Navigate menu, or by pressing CTRL+H.

Click a topic in the History window to display it in the Topic Area. If the Contents pane is active in the Navigation 
Area, the title of the topic displayed in the History window is selected in the table of contents.

Note    You must use the mouse to select a topic in the History window. The keyboard keys are disabled in this 
window.

The History window stays on top of the application main viewer until you close it. The window opens the same 
size and location used when last closed. You can move the window or drag its borders to suit your needs.



How to Use the Library
From the menu at the top of the Navigation Area, select a section of the Library that you want to display in the 
Table of Contents. Then click the item in the Table of Contents to display it in the Topic Area.

Related Topics



What You Can Find in the Library
The Library contains a broad variety of reference material, such as:

Articles and Whitepapers

Knowledge Base

Sample Applications

Books

World Wide Web Sites

Resources

Microsoft Tools

When viewing topics in the Topic Area, you can quickly jump to related information in the Library by clicking 
Related Information (or by choosing Related Information from the Navigate menu).

Note    The Related Information options appear dimmed if no jump to related information in the Library section is 
available.

Related Topics



The Articles and Whitepapers section contains articles about the Internet market outlook, along with various 
technical articles and whitepapers related to the Course contents.



Scroll through over 50 Knowledge Base articles relevant to Microsoft Internet tools and technologies.



The Sample Applications section of the Library contains a few pointers to Web sites that show the creative use 
of tables in Web pages.



In the Books section, you'll find sample chapters from several online books and two books published by MS 
Press.



The World Wide Web Sites section contains pointers that jump to numerous URLs that provide information 
relevant to the World Wide Web and the Internet.



The Microsoft Tools section contains information about various Microsoft Internet-related tools stored on the 
CD-ROM, some of which can be automatically installed.



Explore the Resources Section
In the Resources section of the Library, you'll find the following:

About Microsoft Internet Products. Check out the range of Microsoft products available for creating and 
managing communications over the Internet, including authoring tools and development tools.

Microsoft Future Internet Initiatives. Discusses a few of the Internet-related technologies that will soon be 
available from Microsoft.

Microsoft AnswerPoint-Technical Support Services. Learn about Microsoft AnswerPoint, which provides 
easy access to quality technical support for Microsoft products.

Technical Training and Education. Read about a variety of Microsoft Technical Education options. These 
options include face-to-face, online, and self-paced training.

Publications. Find out about various publishers of Internet-related material.
Microsoft Programs. Learn more about the programs available through Microsoft, including the Microsoft 

Certified Professional Program, the Microsoft Solution Provider Program, and the Microsoft Logo Programs.
Lists and References. Find out about Internet-related events, user groups, and mailing lists.

Related Topics



Create Notebook Entries
You can use the Notebook to mark topics of interest anywhere in the application and make notes about these 
topics. You can return to these notes at any time during the current session or during a future session.

To open the Notebook, do one of the following:

Click Notebook on the toolbar.

From the Edit menu, click Notebook.

Press CTRL+K.
Point to the Navigation or Topic Area, click the right mouse button, and then click Notebook from 

the shortcut menu.
Add or delete a Notebook entry

Add, edit, or delete your notes

Display a Notebook entry in the Topic Area

View notes for current topic

View Help in the Notebook

Print a Notebook entry and/or your notes



To add a topic to the Notebook, click the topic in the Navigation Area, and then:

Click the Notebook icon on the main toolbar to open the Notebook window.

Click the Add To Notebook icon on the Notebook window toolbar to add the topic to the Notebook.

To delete a Notebook entry, select it from the Notebook list and:

Click the Delete icon.



You can add new or edit existing notes. First, add the topic to the Notebook, or select an existing Notebook 
entry, then click in the right pane and type your notes.

Click the Add To Notebook icon to attach your notes to the existing Notebook entry.

You can paste text or graphics from the Topic Area into your notes in the Notebook window. Copy the information
to the Clipboard and then do one of the following:

Click the Paste toolbar button.

Press CTRL+V.
Point to the Notes pane, click the right mouse button, and select Paste from the shortcut menu.

Note    When editing your notes in the right pane, you can use the right-click menu to choose from the standard 
Windows editing commands: Undo, Cut, Copy, Paste, and Select All.



To display a topic entry from the Notebook window in the Topic Area, select the topic in the Notebook window 
and click the Go To Topic icon, or simply double-click the topic in the Notebook window.



Click the Notebook icon above the Topic Area to view the notes for the currently displayed topic.



You can view What's This Help for the toolbar buttons and windows in the Notebook. Simply point to the button 
or window for which you want help, right-click the mouse, and then click "What's This?".



Printing Notes and Notebook Entries
You can print all of the topics that are listed in your Notebook, or print only the current Notebook entry. You can 
also print your notes for the current entry, or print all your notes.

Click the Print icon to open the Print dialog box, and then click your choice of the options defined below.

Choose one of the following:

Print current Notebook topic. Prints the selected Notebook entry.
Print all Notebook topics. Prints all topics that are stored in your Notebook.

You can choose one or both of the following to print the Notebook topic(s) with or without your notes.

Include Topic Text. Prints the selected entry or all Notebook entries.
Include Notes. Prints notes that are associated with the selected entry, or all notes that you've added to 

your Notebook entries.
Click Print to print your choice, or click Cancel to close the dialog box without printing.

Related Topics



Printing Topics and Other Information
You can print the topic that is displayed in the Topic Area. To print, do one of the following:

Click the Print icon on the main or Notebook toolbar.

From the File menu, choose Print.

Press CTRL+P.
Point to the left pane, click the right mouse button, and then click Print from the shortcut menu.

When you choose Print, a standard Windows Print dialog box appears; simply enter your choices and then click 
OK.

Related Topics



"What's This?"-Help About Toolbar 
Buttons, Menus, and Windows
When you want to find out what an item on the screen does, point to the screen element for which you want 
Help, right-click the mouse, and then click "What's This?".



Use Menu Commands
Click a menu command to see a description of what it does.

File Menu

Edit Menu

Navigation Menu

View Menu

Help Menu



When the standard Windows print dialog box appears, enter or click your choices, and then click OK to print.

If you are printing from the Notebook window, click your choices from the Print dialog box, and then click OK to 
print.

Related Topics



Opens the Product Update dialog box, where you can update URL jumps contained in Mastering Internet 
Development.



Closes the application.



Copies the text or graphics that you have selected in the Topic Area or Notebook. To paste your section into 
another application, open the application and then select Paste from the Edit menu, or use the paste 
CTRL+<KEY> combination for that application.

You can paste text or graphics from the Topic Area into your notes in the Notebook window. Copy the information
to the Clipboard and then do one of the following:

Click the Paste toolbar button.

Press CTRL+V.
Point to the Notes pane, click the right mouse button, and then choose Paste from the shortcut menu.



Opens the Notebook, where you can mark topics of interest and make notes about these topics.



Moves to the next topic in the Navigation Area.



Moves to the previous topic in the Navigation Area.



Moves back through the topics that you've viewed.



Displays a list of the topics that you've viewed. Click a topic in the History window to display the topic in the Topic
Area.



Displays a list of topics related to the current topic. Click a topic to display it.

This is the same as clicking Related Information at the bottom of the Topic Area.

Note    These options appear dimmed if no jump to related information in the Library is available.



Displays both the Navigation Area and Topic Area.



Displays the Topic Area only.



Displays the Table of Contents in the Navigation Area.



Displays the Index in the Navigation Area.



Displays the Find pane in the Navigation Area.



Displays a menu from which you can reduce or enlarge text in the Topic Area and in any text viewer (Sample 
Code, Tips, Closed Caption). Simply select one of the following options:

75%: Reduces all text to 75% of its normal size.
100%: Returns all text to its normal size.
150%: Enlarges all text to 150% of its normal size.
200%: Enlarges all text to 200% of its normal size.



Displays the text of video segments in a pop-up window. You can move and resize the window to view the video 
and closed caption simultaneously.

Note    The pop-up window will appear in the same location the next time you open it.



Displays a dialog box when you launch the Internet Explorer from within Mastering Internet Development. 



Opens this Help file.



Displays the Welcome Screen, where you can choose to take the Tour or watch a video introduction of 
Mastering Internet Development.



Displays a menu where you can choose to view the Complete Tour or one of these parts of the Tour:

Getting Around
Finding Information
Keeping Notes and Bookmarks
Customizing How You Work

The Complete Tour is a short multimedia excursion that includes all of the parts listed above.



Displays a glossary of terms and definitions in Help file format.



Launches Internet Explorer 3.0 and goes to the Mastering Internet Development Home page on the Microsoft 
Web site.



Displays name, version, and copyright information for this application.



Shortcut Menus
A shortcut menu is available in the main window and most supplementary viewers at all times, including the right
pane of the Notebook window. The commands on this menu change depending upon where you right-click. 
Simply right-click to display the menu, and then click your choice.

Click the menus below to display a brief description of each command.

Navigation and Topic Area Options

These options appear 
when you right-click in 
the Navigation or Topic 
Area in the main viewer.

A check mark on this 
menu indicates the 
currently active pane or 
window and mode.

When Topic Only is 
selected, you can 
restore the Navigation 
Area by choosing 
Navigation & Topic from
the menu.

Notebook Window Options

The left pane of the 
Notebook window 
displays these options.

The right pane of the 
Notebook window 
displays these standard
Windows editing 
commands.

History Window Options

These options appear 
when you right-click the
History window.

Supplementary Viewer Options



The active text or 
graphic supplementary 
viewers display these 
options:

Note:    The shortcut menu is not available in the Animation, Demonstration, and Point of View viewers.



Displays both the Navigation and Topic Areas in the main viewer.



Displays only the Topic Area in the main viewer. You can restore the Navigation Area by choosing Navigation & 
Topic from the menu.



Displays the Table of Contents in the Navigation Area.



Displays the Index pane in the Navigation Area.



Displays the Find pane in the Navigation Area.



Opens the Notebook window.



Opens the History window.



Opens the standard Windows Print dialog box.



Copies the selected text, or the entire text or graphic displayed in the window, to the Clipboard.



Moves to the previously viewed topic.



Opens the Mastering Series Help file.



Context-sensitive Help for the active screen element.



Adds the displayed topic to the Notebook. You can add notes to this entry as well.



Deletes the selected Notebook entry.



Deletes the selected text in your Notes window.



Goes to the selected Notebook topic and displays the text and associated media icons in the Topic Area.



Opens the Print dialog box. You can print a selected Notebook entry or all entries with or without your notes. Or, 
you can print the notes associated with the selected Notebook entry or all of your notes. After making your 
selection and clicking Print, the standard Windows Print dialog box appears.



Pastes text from the Clipboard into the Notes window.



Undoes the previous edit made in the Notes window.



Cuts the highlighted text from the Notes window and copy it to the Clipboard.



Selects all text in the Notes window.



A Help topic is not available for this item.



Using Setup to Uninstall
To uninstall Mastering Internet Development from the Setup program, follow these steps:

1. Run Setup from the CD-ROM.
2. Click Remove All.

Note    Do not choose to remove shared DLLs unless you are sure they are not being used by other 
applications.



Using Control Panel to Uninstall
To remove Mastering Internet Development from your system using the Control Panel, follow these steps:

1. From the Control Panel, click Add/Remove Programs.
3. Select Mastering Internet Development and click Add/Remove.
4. Click Remove All.

Note    Do not choose to remove shared DLLs unless you are sure they are not being used by other 
applications.



Print. Click to print the entire topic that is displayed in the Topic Area.

Copy. Click to copy highlighted text or the entire topic displayed in the Topic Area. You can 
paste your selection into another application, or into your Notebook. (Open the Notebook 
window, click the right pane, and press CTRL+V.)

Navigation & Topic. Click to display the Navigation Area in the left pane while viewing the 
Topic Area in the right pane. To close the Navigation Area and display only the Topic Area, click
Topic Only.

Topic Only. Click to close the Navigation Area and display only the Topic Area. To display both
areas, click Navigation & Topic.

Notebook. Click to open the Notebook, where you can store a list of topics of particular 
interest, along with your own notes about them.

Glossary. Click to view an extensive glossary of Internet-related terms and definitions.

Help. Click to get Help for Mastering Internet Development Using Microsoft Tools.

Add to Notebook. Click to add the selected topic to your Notebook.

Delete. Click to delete the selected topic from your Notebook.

Print. Click to print topics or your notes from your Notebook.

Paste. Click to paste selected topic text or contents of the Clipboard to your Notes in the 
Notebook window.

GoTo. Select a topic in the Notebook and then click to display the topic in the Topic Area.

You can also go to a topic by double-clicking the topic in the Notebook window.

Contents. Click to view the Table of Contents in the Navigation Area, and then click an entry to display a topic in
the Topic Area.



Index. Click to view and search through an index of the Course and Library.



Find. Click to perform a precise search for a word or topic. You can type a word or phrase, or select a previous 
search string from the drop-down list. Mastering Internet Development Using Microsoft Tools supports boolean 
search operators.



Click to display Related Information, then click a topic from the list to display it in the Topic Area.



Back. Click to go back through the topics that you've previously viewed.

To view a list of all the topics that you've previously visited during the current session, choose History from the 
Navigate menu to open the History window.



Previous. Click to move to the previous topic in the Navigation Area.



Next. Click to move to the next topic in the Navigation Area.



The Navigation Area is in Contents pane mode. You can select a category from the Course or Library menu, 
scroll through the topics displayed, and click a topic to view it in the Topic Area.

You can switch the Navigation Area to display the Index or Find pane by clicking one of these icons at the top of 
the Navigation Area:

Index. Displays Index entries related to 
particular topics in the Course and the 
Library.

Find. Displays the Find pane, where 
you can perform a precise search for a 
word or topic.

The Navigation Area is in Find pane mode. You can type a word or phrase, or select a previous search string 
from the drop-down list. To search for a phrase, enclose the phrase in quotation marks.

Click a found topic to display it in the Topic Area.

You can switch the Navigation Area to display the Contents or Index pane by clicking one of these icons at the 
top of the Navigation Area:

Contents. Displays entries for the 
Course components or Library sections.

Index. Displays Index entries related to 
particular topics in the Course and the 
Library.

The Navigation Area is in Index pane mode. You can click the text box and type the first few letters of a word; 
the index will scroll to the closest entry and list related topics in the box at the bottom. Click an Index entry to 
display the topic in the Topic Area.

You can switch the Navigation Area to display the Contents or the Find pane by clicking one of these icons at the
top of the Navigation Area:

Contents. Displays entries for the 
Course components or Library sections.

Find. Displays the Find pane, where 
you can perform a precise search for a 
word or topic.

The Topic Area always displays content, whether it be a selection from the Table of Contents in the Navigation 
Area, a topic related to an Index entry, or the topic you've selected from the Find hits list. Click a topic in the 
Navigation Area to display it in the Topic Area.



Print Notebook dialog box. Click your selection to print the current Notebook topic or all topics stored in your 
Notebook. You can print your notes or topic text, or both.



Lists the Notebook entries, including those topics to which you have added notes. To display a Notebook entry 
in the Topic Area, double-click it; or, select the Topic and click the Go To button on the toolbar.

To add, edit, or delete notes for a particular topic, click the entry, then add, revise, or delete the notes that are 
displayed in the Notes window.



Displays the Notes that you have created for particular topics. Click this window to add or revise notes.



Popup graphics can be displayed in two sizes; click once on the graphic to expand or reduce the window.

You can print or copy the graphic to the Clipboard by using the appropriate command from the shortcut menu. 
Simply right-click the mouse, then click Print or Copy.



The Sample Code window opens to the same size and location used when last closed. You can resize the 
window by dragging its borders.

You can select sample code to copy it to the Clipboard. Or you can print or copy all of the sample code that is 
displayed in the window. Simply right-click the mouse to display the shortcut menu, then click Print or Copy.



The Self-Check Answer window opens to the same size and location used when last closed. You can resize 
the window by dragging its borders.

To view an answer, click the Answer icon.

You can print or copy an answer to the Clipboard. Simply right-click the mouse to display the shortcut menu, 
then click Print or Copy.

Note    You can print or copy the questions displayed in the Topic Area by clicking the Print icon on the main 
toolbar, or by using the shortcut menu in the Topic Area.



The Tip window opens to the same size and location used when last closed. You can resize the window by 
dragging its borders.

You can select a portion of the tip to copy it to the Clipboard. Or, you can print or copy the entire tip. Simply right-
click the mouse to display the shortcut menu, then click Print or Copy.



The History window opens to the same size and location used when last closed. You can move it or drag its 
borders to adjust its size to suit your needs.

Click a topic in the History window to display it in the Topic Area. If the Contents pane is active in the Navigation 
Area, the title of the topic displayed in the History window is selected in the table of contents.

Note    You must use the mouse to select a topic in the History window. The keyboard keys are disabled in this 
window.

The History window stays on top of the application main viewer until you close it.



The Closed Caption window opens to the same size and location used when last closed. You can move the 
window or drag its borders to resize it to suit your needs.

You can select to select a portion of the text to copy it to the Clipboard. Or, you can print or copy the entire text 
displayed in the window. Simply right-click the mouse to display the shortcut menu, then click Print or Copy.



Top Support Issues in Interactive Media 
Applications
The following sections describe problems some customers have had with Interactive Media products, along with 
possible solutions. 

Interactive Media products, ranging from kids' products to reference and geography titles, are split into three 
multimedia areas:

CD-ROM
Sound
Video Playback

This table shows the current top issues for each of the areas based on the frequency of each support issue 
since the beginning of 1996. Three of the nine issues listed in the table are described in detail in the following 
sections (each one indicated by an asterisk).



Issue 1:    CD-ROM Capacity Limit 
Exceeded
Description
Not all CD-ROM drives can access all the data a CD-ROM can hold, so attempts to access files outside the 
readable area will result in errors. To read the entire CD-ROM, the customer either has to get the product on a 
non-CD-ROM medium (if available) or upgrade his or her system to a CD-ROM drive with sufficient capacity. In 
some cases, it is only necessary to upgrade the firmware of the CD-ROM.

Calls on this topic can be long because the problem can be caused by many factors and because this issue 
cannot be resolved in real time for the customer. The average length of a support phone call for this problem is 
more than 33 minutes.

The constantly changing hardware industry and the fact that many customers have no idea what CD-ROM drive 
they have can also make finding the source of the problem difficult. Even leading upgrade kits can use a variety 
of different vendors for the CD-ROM drive, although packaging may be the same. 

See the Knowledge Base (article # Q141329) for more information about this issue.

Support Recommendation
Either don't create CD-ROM products that exceed the read capability of older CD-ROM drives or, if you 
absolutely must squeeze the last possible bit of data onto a CD-ROM, put those nonessential or infrequently 
used files in the areas that might not be readable by all CD-ROM drives.

Provide support groups with the physical location of files on the CD-ROM to help them troubleshoot errors 
reading files. If the support engineer knows that the problem file is well within the area that all CD-ROM drives 
can read, he or she can eliminate CD-ROM capacity as the problem and troubleshoot the problem more 
efficiently.



Issue 2:    CD-ROM Cache Setting Wrong 
(WIN 95)
Description
Incorrect cache settings for the CD-ROM drive hurt the performance of the drive (jumpy audio/video, read 
errors). Windows 95 might not be able to determine the correct cache setting during detection of the CD-ROM 
device. Generally, the support engineer will recommend that the supplemental cache size be set as large as 
possible. This advice is starting to appear in product README files, such as those for Bookshelf for Windows.

See the Knowledge Base (article # Q141368) for more information and for recommendations on how to specify 
the appropriate cache size for different media types.

Support Recommendation
Windows needs to do a better job of choosing the appropriate cache settings for CD-ROM drives, but until then, 
products that rely on a minimum level of CD-ROM performance need to recognize when that performance is not 
being delivered and help customers troubleshoot the problem. One way to help is to ship the Multimedia 
Troubleshooter (part of MSInfo 2.5) with your product.



Issue 3:    CD Audio MCI Driver(s) Not 
Installed
Description
The product cannot play CD Audio sound because the necessary drivers are not installed. For example, the 
Windows 95 typical installation does not install the CD Audio (CD Player) capability under some circumstances, 
such as if it was installed from floppy disks or the CD-ROM was not detected correctly during network 
installation. 

Because of the unambiguous error message and straightforward solutions, the average length of support calls is
only 12 minutes.

Depending on how the support engineer judges the capabilities of the customer, the engineer will either walk the 
customer through the actual driver installation or simply provide the customer with instructions.

Potentially complicating the problem is the chance that a customer does not have ready access to a Windows 95
CD-ROM that contains the necessary files, either because he or she purchased Windows 95 on floppy disk or 
because Windows 95 was preinstalled and the OEM did not provide disks. 

We recently put the CD Audio drivers on MSDL (Microsoft Download) so that customers who fall into this group 
and have a modem can download the drivers and instructions. If a customer does not have a modem, he or she 
can contact the OEM or can call Windows support for additional assistance.

See the Knowledge Base (article # 139659) for more information about this issue.

Support Recommendation
In the short term, products that depend on a technology or driver should, at the very least, verify that the 
necessary driver and/or technology is installed. If not, a useful error message should be provided to help the 
users resolve the issue.

For the long term, we recommend that products recognize when a critical component is missing and actually 
walk the customer through the installation. For instance, a CD-ROM product requiring CD Audio support would 
actually alert the customer and launch an "intelligent" Windows setup program to install the component.



Support Maxim
The anonymous quote, "Every time history repeats itself the price tag goes up," illustrates the reason for this 
month's maxim:

Avoid Even/Odd (Flip/Flop) issues.

Description
When a product group decides to change a feature to eliminate support issues, it should understand why the 
feature was originally implemented. Doing so avoids accidentally swapping one set of problems for another 
between alternate releases.

The issue "CD Audio MCI Driver(s) Not Installed" shows how this maxim could be applied to prevent flip-flopping
of issues between subsequent releases.

With a high frequency of support, CD Audio might not seem like the way to go about delivering audio on future 
CD-ROM products. But CD Audio was chosen over WAV audio or MIDI because WAV and MIDI audio also have 
a large number of support issues and are difficult for customers and support engineers to troubleshoot. 

By comparison, the CD Audio issue is much easier to resolve. A strong case can be made for releasing more 
products using CD Audio as the primary source of sound and improving the product error messages and 
troubleshooting assistance. Taking this route could make it easy for customers to resolve the issue without 
calling AnswerPoint support. 

For More Information
For more information, visit these web sites.

AnswerPoint:    http://www.microsoft.com/supportnet/AnswerPoint/
Support Online:    http://www.microsoft.com/support/
Knowledge Base:    http://www.microsoft.com/kb




